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Commands
To get help for the menu commands below, choose the appropriate menu title.

For further information on using help, press F1 or choose Using Help from the Help menu.

File Menu Commands
New
Open
Compare
Save
Save As
Print
Print Setup
Exit

Edit Menu Commands
Copy
Machine Name

Test Menu Commands
Processor
Memory
Graphics
Disk
Windows
Everything
Three Test Average
Disable Input

System Menu Commands
System Information
CONFIG.SYS
AUTOEXEC.BAT
WIN.INI
SYSTEM.INI
Restart Windows
Reboot System

Help Menu Commands
Contents
Search for Help On
Analyse Results
How to Use Help
About Benchmarks



Basic Skills
The Basic Skills list gives you information about the basics of the Windows User Benchmarks.
Use the scroll bar to see more items if necessary.

For further information on using help, press F1 or choose How to Use Help from the Help 
menu.

Running the Benchmarks
Running the Benchmarks
Running Individual Tests

General
Printing the Display
Using the Clipboard
Viewing System Information



Advanced Techniques
The Advanced Techniques list gives you information about advanced topics. Use the scroll 
bar to see more items if necessary.

For further information on using help, press F1 or choose How to Use Help from the Help 
menu.

Obtaining Accurate Results
Analysing the Results
Comparing Tests



Glossary
The Glossary topic gives you definitions of commonly used terms.

For further information on using help, press F1 or choose How to Use Help from the Help 
menu.

Benchmark
Bitmap
Cache
CIX
Colour Depth
CPU
Disk Fragmentation
Expanded Memory
Extended Memory
IDE
Landmark
Metafile
MIPS
Rebooting
Reference System
SCSI
Shell
Status bar
Tool bar
Wait States
WIN87EM.DLL



File Menu Commands
Use the scroll bar to see more commands.

New
Clears any previous benchmark results.

New will zero the results of any previous tests, ready for you to perform a new set of 
benchmarks. The New command will also turn off the benchmark display's 'monitor'.

Related Topics
Running the Benchmarks

Open
Opens a previously saved set of benchmark results.

Open will load in a previously saved .MRK file and display the overall results. You can then 
print them out, copy them to the clipboard, or compare them with another set using the 
Compare command.

Related Topics
Comparing Tests
Printing the Display
Using the Clipboard

Save
Saves a copy of the current test results.

If the current file is 'Untitled' then you will be prompted with a dialog box to specify the file 
name. You can only save the tests once a complete run has been performed.

Related Topics
Comparing Tests

Save As
Saves a copy of the current file under a specified name.

If the file already exists then you will be prompted to say if you wish to overwrite the older 
copy.

Related Topics
Comparing Tests

Print
Prints the current display.

The current display is printed, although any icons on the display will not appear.

Print Setup



Sets up a printer.

Displays the standard Windows printer setup dialog box. You can use this dialog box to 
change your active printer or modify its settings.

Exit
Exits the Windows User Benchmarks.



Edit Menu Commands

Copy
Copies the display to the clipboard in text, bitmap and metafile formats. You can then paste 
the results in any of these formats into another application.

Related Topics
Using the Clipboard

Machine Name
Allows you to enter a name for your machine. This will appear on result printouts and on the 
comparison graph.

Related Topics
Comparing Tests



Test Menu Commands
Use the scroll bar to see more commands.

Processor
Tests the processor speed. The maths co-processor (or a Windows-based emulation of it) is 
also tested.

Memory
Tests the speed of memory allocations within Windows.

Graphics
Tests the speed of graphics operations. Only a few operations are tested; these are the most 
significant ones for the majority of common Windows applications.

Disk
Tests the speed of the hard disk. If you have more than one hard disk, then the Benchmarks 
use whichever disk is used by Windows for creating temporary files.

Windows
Tests the speed of Windows in a variety of operations, including DOS session speed. If you 
are running in Standard Mode, then the windowed DOS tests are replaced by full screen DOS
session tests.

Related Topics
Running Individual Tests

Everything
Performs the complete suite of benchmark tests.

Related Topics
Running the Windows User Benchmarks

Three Test Average
Runs the complete suite of benchmark tests three times and displays an average result. Use 
this setting, with input disabled, to obtain the most accurate results.

Obtaining Accurate Results

Disable Input
Disables keyboard and mouse input during testing to make the results more accurate.

Related Topics
Obtaining Accurate results



System Menu Commands
Use the scroll bar to see more commands.

System Information
Displays a dialog box giving detailed system information, divided into DOS/hardware and 
Windows-specific sections.

Related Topics
Viewing System Information

CONFIG.SYS
Edits your CONFIG.SYS file using Notepad. Reboot your system to make the changes take 
effect.

AUTOEXEC.BAT
Edits your AUTOEXEC.BAT file using Notepad. Reboot your system to make the changes take 
effect.

WIN.INI
Edits your WIN.INI file using Notepad. Restart Windows to make the changes take effect.

SYSTEM.INI
Edits your SYSTEM.INI file using Notepad. Restart Windows to make the changes take effect.

Restart Windows
Restarts Windows to make any changes to WIN.INI and/or SYSTEM.INI take effect.

Reboot System
Reboots your machine to make any changes to AUTOEXEC.BAT and/or CONFIG.SYS files take 
effect.



Help Menu Commands
Use the scroll bar to see more commands.

Contents
Shows the Contents page of this Help system.

Search for Help On
Displays the keyword search dialog of the Help system.

Analyse Results
Analyses the benchmark results.

The Analyse command displays a dialog listing the results of the benchmark analysis. 
Double click on a title in the list to display the required information.

Related Topics
Analysing the Results
Obtaining Accurate Results

How to Use Help
Displays the help for the Help system.

About Benchmarks
Displays the copyright and version information.



Running the Benchmarks
The best way of running the Windows User benchmarks is to click on the 'GO' button at the 
left hand end of the tool bar, or by selecting 'Everything' from the Test menu. This will start a
series of system tests, displaying the results after approximately two to three minutes 
depending upon the speed of the PC. 

The tests are designed to check the performance of all parts of your system, from your CPU 
right through to the graphics controller and hard disk. Don't worry if your monitor makes a 
clicking sound during the DOS session tests - this is normal for some multisync monitors as 
they switch modes.

As the tests progress, the icons at the bottom of the screen give the individual results for 
each of the five components of each test. The grey status bar at the bottom of the screen 
shows the progress of each test in percentage terms.

The results are given in the form of a comparative bar chart which compares your machine 
with four reference systems ranging from low-powered machines to high-powered 
workstations. Most machines will fall somewhere in between.

The red bar shows your machine, and the blue bars show the reference systems. The individual 
components are displayed along the bottom of the screen.

Once all the results have been calculated you can use the Analyse Results button or menu item to 
give you more details of your system's relative speed, as well as any bottlenecks which may 
be occurring.

Unless the Disable Hardware option is checked, the tests can be interrupted at any time by 
pressing the Esc key. However, disabling hardware input gives much more accurate results.

Individual results
You can also run the individual benchmark components one at a time by using the five 
buttons in the tool bar or by choosing the component items from the Test menu. After 
running individual tests a bar chart will be displayed, comparing your system's performance 
on the test with four reference systems. However, the Analyse Results option is only 
available if the most recent test completed was the overall test or if you open a previously 
saved .MRK file.

See also:
Running Individual Tests
Obtaining Accurate Results
Comparing Tests
Printing the Display
Using the Clipboard



Running Individual Tests
The individual tests can be run using the buttons on the tool bar or by selecting individual 
test items from the Test menu. Once completed, the results are displayed in a bar chart 
together with four reference systems.

The tests are discussed below in their five categories. Whilst every care has been taken to 
ensure that the results are generally reproducible to within ±3%, results cannot be 
guaranteed to be exactly the same during each test session because of the constantly 
changing nature of the Windows system. It is advisable to take the average value over three 
or four testing periods, particularly when running the Windows User Benchmarks on 
machines with low memory, 

Processor
The processor tests check the speeds of general CPU operations:

· Memory moves
· Register processing
· Near and far jumps
· Integer calculations
· Floating point calculations

The tests are weighted in favour of simple memory and register operations and integer 
arithmetic. The floating point calculations do not have a huge bearing on the overall figure, 
since most Windows software does not require or use a maths co-processor explicitly. Where 
a co-processor (or 486DX) is not installed, the calculations are carried out using the 
WIN87EM.DLL library. Calculations involving the use of this library may be up to an order of 
magnitude slower than they would be with a hardware co-processor installed. Floating point 
calculations tests are carried out using both double and IEEE 80-bit representations, to cater 
for the needs of a broad range of applications such as spreadsheets, CAD packages and 
science and engineering software.

Memory
Memory speed is no longer a major issue in PC design, as most modern processor chips have
a cache for enabling near-zero wait state access. However, under Windows the amount of 
memory and its fragmentation will affect performance greatly.

The test checks:

· Local memory
· Global memory (32K to 128K)
· Global memory (256K to 512K)
· Memory copy
· Memory set

Both local and global memory is tested, although the weighting system places more 
importance on the global memory results since local memory is usually not used for 
anything other than temporary storage.



Graphics
The graphics display is the biggest single factor in the perceived speed of a Windows 
system, and may well make the difference between a computer with a fast CPU seeming 
sluggish or quick.

The test checks the following:

· Bitmap drawing ( 2, 4, 8 and 24-bit BitBlt functions)
· Bitmap stretching (2, 4, 8 and 24-bit StretchBlt functions)
· Vector graphics drawing (lines, curves and complex filled regions)
· Filled rectangle drawing
· Scrolling
· Text output (in a variety of faces, sizes and styles)

The graphics tests are designed to test the most frequently called graphics routines. For 
example, the Arc/Ellipse routines are rarely called by Windows applications and are thus 
given comparatively little weighting in these tests, but the FillRect function is widely used. 
The graphics test results are highly dependent on the type of graphics system present, the 
chipset in use and the display driver, although the speed of the CPU and bus will have a 
bearing.

Hard disk
The hard disk is one of the most crucial elements in a Windows system, since Windows relies
on reloading code segments from disk as memory is discarded. In enhanced mode, the 
efficiency of a swap file set up to allow virtual memory usage also depends upon the hard 
disk speed.

The following are tested:

· Small size file read/writes (20 bytes to 5K)
· Medium size file read/writes (10K to 256K)
· Large size file read/writes (512K to 2Mb)
· Temporary file creation/deletion
· General disk operations

The disk tests automatically use the fastest hard disk available. SmartDrive (or any other 
disk cache) is enabled for the duration of the tests, but the write cache buffer (if any) is 
flushed, giving a truer reflection of hard disk speed. The tests are weighted towards medium
size files, since the smaller and larger sizes are atypical of most Windows applications. 
General disk operation tests include creation and deletion of files and random read/writes.

Windows
The final test checks general Windows specifics which are not covered in the previous tests. 
To a large extent this involves checking internal functions as well as the speed of DOS box 
operations.



The tests include:

· Dialog box creation
· Window management
· Windowed DOS session (full screen for 286's in standard mode)
· Full screen DOS session
· General Windows functions from the GDI, USER and KERNEL libraries

The use of the DOS session leads to a slight inconsistency in the results between 286 and 
386/486 machines, since machines operating in standard mode cannot open windowed DOS 
sessions. This is not a problem, as long as it is realised that measuring standard mode 
operation against enhanced mode operation is not a valid comparison.

Do not be alarmed if the monitor clicks loudly during the full screen DOS test. Multisync 
monitors which use separate relays to switch in the different scanning frequencies may 
exhibit this phenomenon.



Printing the Display
The results display can be printed by selecting the Print option from the File menu or by 
clicking on the print button in the tool bar. Printing is disabled if there are no results 
displayed. Icons at the bottom of the display are not printed.

You can configure your printer by using the Print Setup dialog box to change printer, paper 
size and orientation and paper source.



Using the Clipboard
The clipboard can be used to paste the displayed results graph into another application. The 
following formats are available:

· ANSI text
· Windows bitmap
· Windows metafile
· OEM text

The metafile does not contain any bitmaps, but is scalable and will print at the full resolution
of any output device. The resolution of printed bitmaps is restricted to the resolution of your 
display.



Viewing System Information
The Windows User Benchmarks can provide a wealth of information about your hardware 
and system software. The System Information dialog allows you to select information on two 
topics:

· DOS
The processor type, presence of co-processor, memory and hardware configuration are 
listed. The extended memory value is the total extended memory in addition to the base 
1Mbyte of conventional memory.

The DOS version is listed, together with the name of the network driver which is currently
being used.

· Windows
Version and configuration information for your Window setup is displayed, including 
screen resolution and number of colours, swap file information and resources. The 
system resources value displayed in Program Manager's About box is in fact the lower of 
the GDI and USER values which are displayed by the benchmarks.



Obtaining Accurate Results
Whilst every effort is made by the benchmark program to obtain accurate results, successive
tests may give slightly different results. This can be due to many factors, including software 
and/or hardware disk cacheing and memory fragmentation. We recommend that the tests 
are carried out more than once and an average value taken for greatest accuracy. In order to
facilitate this process, the Three Test Average command on the Test menu can be used. This 
will run through the complete suite of tests three time and display an average over all three 
tests.

You can also make your results more accurate by running with only your shell program 
loaded (Program Manager, for example) and by using the Disable Input option to turn off the 
mouse and keyboard hardware during the tests. If input is disabled, you will not be able to 
cancel the tests by using the Esc key.



Analysing the Results
Once all the tests have been completed, the Analyse option on the Help menu (and the 
Analyse button on the tool bar) will become available. Choosing Analyse displays a dialog 
with a list of options. In addition to a general results analysis and help in optimising the 
performance of your system, the Benchmarks may also highlight any bottlenecks. These are 
components which are markedly slower than the rest of your system. 

Sometimes these bottlenecks can be cleared easily. For example, your system might exhibit 
a poor display speed which can be improved by switching to a lower resolution or colour 
depth. Similarly, hard disk performance may be improved by enabling SmartDrive or 
configuring a hard    disk cacheing controller correctly. Often, however, hardware 
replacement is the only solution.



Comparing Tests
After a complete set of tests has been run you can save the results with a representative 
name for your machine (entered using the Machine Name... option on the Edit menu). The 
date the tests are carried out is also saved.

You may also compare the current set of results with a previously saved set. Both machine 
names and test dates are displayed alongside a comparative bar graph. Using file 
comparison in this way can help you fine tune your system and gauge the benefits of any 
hardware changes or software optimisation.



About Windows User
Windows User, from Reed Business Publishing, was the first newsstand magazine devoted 
solely to all things Windows. Each month, Windows User analyses all the news from the 
world of Windows, reviews major new hardware and software products and provides a wealth
of background information for Windows users everywhere.

Windows User is well known for the quality of its in-depth reviews and for its coverage of 
Windows hardware. A thriving question-and-answer section and the innovative Points and 
Clicks pages serve to make Windows computing easy and fun for all our readers.

Windows User also runs a conference on the CIX on-line service - at the prompt type join 
windows_user. This is an open conference where readers and the Windows User team can 
discuss issues arising from the magazine, swap ideas and explore some of the cultural issues
surrounding Windows. In addition we try to deal with readers' technical problems, and 
shareware programs, macros and hints and tips are regularly uploaded to the file area.

Contact Windows User at:
Quadrant House
The Quadrant
Sutton
Surrey
SM2 5AS

Editorial
Tel: 081-652 3662
Fax: 081-652 8943

Advertising
Tel: 081-652 8415
Fax: 081-652 8943

Subscriptions
Circulation Department
Windows User
Oakfield House
Perrymount Road
Haywards Heath
West Sussex
RH 16 3DH

Tel:(0444) 445566

Credit Card Hot-line (0622) 721666



 About the Reference System

As with all benchmarking systems, a reference system is required to provide a baseline for 
the results. The old-fashioned concept of IBM PC = 1.0 obviously doesn't apply to machines 
running Windows, so instead a "standard" Windows system was chosen and assigned an 
overall index of 10.0. The reference system is a 486-based PC and has the following 
configuration:

· 33MHz i486 processor with 64K secondary processor cache
· 8 Mbyte 70 ns RAM
· 211 Mbyte hard disk, 15ms access time
· 1 Mbyte cacheing IDE controller
· SuperVGA graphics running at 640 x 480 x 16 colours
· MS-DOS version 5.0
· Windows version 3.1

This machine represents a fast Windows setup suitable for high powered applications, 
although the low screen resolution would preclude its use in professional desktop publishing 
and CAD applications or programming environments such as Visual Basic. The five Windows 
User benchmark components each have an index of 10.0 on the reference machine, giving 
an overall benchmark of the same figure.



About Inova
Inova is a software design, documentation and marketing consultancy located in Highgate, 
North London. Inova offers a range of services including technical writing, bespoke software, 
marketing consultancy, literature design and printing.

Inova consultants have a wide variety of experience, including commercial Windows 
programming, print buying, project management and business consultancy.

For more information, contact Mark Stephens.

Inova
West Hill House
6 Swains Lane
Highgate
London N6 6QU

Tel: 071-482 4212
Fax: 071-267 9188

CIX: marx@cix.compulink.co.uk
CIS: 70734,275
BIX: mstephens



What do the Numbers Mean?
The numbers are based around a reference system consisiting of a 486/33 PC with 
SuperVGA graphics and a cacheing hard disk controller. The system is given a benchmark of 
10.0, with faster machines having larger numbers and slower machines having smaller 
numbers.

The subjective speed of your Windows setup depends not only on your machine hardware 
(and how well it has been optimised) but also on the software which you use. A drawing 
package will be fast on a machine with an accelerated video card, but the improved display 
speed may not be so apparent with a spreadsheet or word processor.

The numbers themselves are only representative of speed. They have no relation with any 
physical parameters, unlike the MIPS and Landmark tests. However, due to their broad 
nature they give a good indication of the real-world performance of Windows and its 
applications on your PC.

See also
Optimising Enhanced Mode
Optimising Standard Mode



General Results
Your system runs like a 286.

Despite what many people say, it is quite possible to run Windows on a reasonably fast 286 
machine. Ideally you should have a fast hard disk and 4Mb RAM, although a single 
application should be able to squeeze into 2Mb RAM.

286 machines can only run in standard mode, and so cannot multitask DOS programs nor 
use part of the hard disk as virtual memory. However, standard mode has some advantages 
over 386 enhanced mode operation - notably speed - so many people prefer to run standard 
mode even on 386 and 486 machines.

If you find that your 286 is too slow for Windows, even with 4Mb RAM, then it may be 
possible to upgrade its motherboard - a 25MHz 386SX would be a good choice. Whether or 
not this is feasible will depend upon the characteristics of the original system, and whether 
or not you can reuse expansion cards such as the hard disk controller. With most clones 
there should be few problems, but look out for memory compatibility and the presence of 
disk and video controllers which are integrated with the motherboard.



General Results
Your system runs like a slow 386.

Machines in this bracket include 16 and 20MHz 386 SX's and DX's. The machine's lack of 
speed may well be caused by wait states being required due to the processor having no 
cache. Unfortunately most motherboard designs do not allow a cache to be retro-fitted, so 
you will require a new motherboard for any great improvement.

It is usually possible to increase the speed slightly by adding more memory up to about 
8Mbyte. If you have a comparatively slow hard disk but 8Mbyte RAM, then dedicating 
1Mbyte to SmartDrive and 1Mbyte to a RAM disk for temporary files should prove to be a 
good combination.

A graphics card with an accelerator chip should also help to speed things up, relieving the 
CPU from the onerous task of moving large amounts of data to the display. S3-based cards in
particular are now as cheap as fast VGA cards, and should give a large improvement in 
subjective speed.



General Results
Your system runs like a medium speed 386.

Medium speed 386's include cached 20 and 25MHz SX and DX's. You may also find that a 
33MHz 386 gives this result due to video or hard disk bottlenecks. If this is the case you 
should consult the optimisation section of the Benchmarks help system in order to address 
these problems.

A medium speed 386 is generally suitable for running all but the most complex of Windows 
software. The actual size of any processor cache present (usually 64K or 256K) has a slight 
bearing on overall speed, although the difference between cached and uncached CPUs is 
much larger. 386 PCs will benefit from a matched video card like those based on the Tseng 
ET4000 chip set, and a fast hard disk. If you are upgrading, then look for disks with an 
access time of less than 19ms.



General Results
Your system runs like a fast 386.

Machines in this group include 33 and 40MHz Intel and AMD 386's. You may also find that 
slow (20MHz) 486SX's give this result due to video and hard disk bottlenecks.

The 33MHz and 40Mz 386's from Intel and AMD represent the limit of 386 technology. You 
can increase your overall CPU index by adding a maths co-processor, but there is little else 
you can do to improve the speed of the heart of your machine without replacing the CPU. 

Some recent systems make this easy, with the CPU and cache components being located on 
a separate module which can be replaced easily. However, many systems will require that 
you replace the motherboard in its entirety.

Fast 386's are suitable for all CPU tasks, although you may find that a maths co-processor is 
a necessity for statistical, numerical software or CAD packages.



General Results
Your system runs like a medium speed 486. 

Such systems include 25MHz and 33MHz 486SX and 486DX-based machines. This category 
may also cover 50MHz 486s whose processor speed is not matched by equally powerful 
graphics and disk hardware.

The medium speed 486 is the current mainstay of personal computing - many 
manufacturers are now turning to the 486 as their entry level machine. The Intel 486 CPU 
has an on-board cache of 8K, although it will benefit from an external cache of 64 or 256K of 
fast static RAM.

The 486SX procvessor is identical to the DX chip, except that the built-in maths co-processor
is disabled. In order to upgrade the 486SX you can add a 487SX chip, a standard 486DX with
an additional pin which will disable the existing486SX.

Many new 486 computers can also be upgraded by using the Intel OverDrive upgrade 
processor, the DX2. This is a standard 486 chip which works internally at twice the speed of 
your current system board, so a 25MHz board could use a 50MHz 'clock doubler' and a 
33MHz board could take the 66MHz DX2. While an OverDrive processor will not double 
performance, as the memory and peripherals will still be addressed at the original speed, it 
will generally improve the overall speed of your system, particularly for computationally 
intensive tasks.



General Results
Your system runs like a fast 486.

Fast 486s range from 33MHz systems with fast hard disks and graphics cards to 66MHz 
DX2s. These cover the current top end of the PC market and are generally supplied with fast 
(<15ms access) hard disks, possibly with hardware cacheing, and accelerated graphics 
cards.

If your system does not have these extra peripherals, then it may be worth thinking about 
them as an upgrade. A graphics accelerator card, for example, will give a marked 
improvement in Windows performance in many cases, especially if you choose one based on
the TI34020 co-processor. In general you should match the hardware upgrade to your 
purpose, so if you only use a database at low resolution a hard disk upgrade might be more 
worthwhile.



General Results
Your system runs like a very fast 486.

Currently the fastest 486s are those based on the Intel 486DX2 running at 66MHz. However, 
clock doubling to 100MHz is also possible, so we may see the appropriate DX2 chip released 
soon.

If your system obtains this result then it probably has a fast graphics co-processor, perhaps 
based around the TI34020 chip set running at a low resolution or colour depth, and a fast 
cacheing hard disk controller.



Memory Bottleneck
Your system has a memory bottleneck. This means that under Windows your memory cannot
keep up with your CPU. This problem may be due to one of two reasons: either you have too 
little memory installed in your machine (or not enough is allocated to Windows), or your 
memory is addressed too slowly.

Too little memory for Windows
Windows requires at least 4Mbyte to work well on a system. Although 2Mbyte operation is 
possible it is not recommended. Windows will also work much better on a 5-8Mbyte system 
than one with 4Mbyte RAM.

If you use an expanded memory manager such as EMM386.EXE to provide LIM EMS 
expanded memory, then this will reduce the amount available to Windows. RAM disks and 
disk caches will also reduce the amount of available extended memory which Windows can 
use for programs and data. If you need expanded memory outside of Windows, then it may 
be worthwhile investing in a third party expanded memory manager which can provide both 
expanded and extended memory to applications on a need basis. If you use a disk cache or 
RAM disk, then use the following guidelines:

System RAMDisk Cache RAM Disk
2 Mbyte 0 Mbyte 0 Mbyte
4 Mbyte 512 Kb 0 Mbyte
6 Mbyte 1 Mbyte 512 Kb
8 Mbyte 1 Mbyte 1 Mbyte
16 Mbyte 1 Mbyte 2 Mbyte

If you use a RAM disk, then set your TEMP variable to point to it. You may find that you 
require a larger RAM disk than the sizes shown if you regularly print large bitmaps which 
may overflow the available space.

There is little, if anything, to be gained from increasing the size of your hard disk cache 
beyond 1Mbyte.

Memory too slow
Your system's memory may be too slow for one of two reasons: either the physical speed of 
the memory may not be fast enough, due to slow chips or the lack of a static RAM cache, or 
else your cache may be improperly configured.

There is little you can do if your system does not have a cache and cannot be fitted with 
one, but if you do have a hardware cache then you should make sure it is properly 
configured and that it caches the whole of the address space.



Disk Bottleneck
Your system has a hard disk bottleneck. This means that the access time and/or transfer rate
of your hard disk is not fast enough to keep up with the rest of your system.

Hard disk speed is measured by a number of components, the chief amongst them being the
average access speed (the time it takes for the read/write head to move to a particular point
on the disk surface) and the rate at which data is transferred between the hard disk and the 
CPU.

A large number of factors affect hard disk performance: hard disk type, presence of a 
hardware or software cache, and the fragmentation level. Each of these factors is discussed 
below.

Hard disk type
The hard disk type determines its capacity, physical access times and data transfer rates. In 
fact, the type of interface between the hard disk and the CPU is also a factor in transfer 
rates. Most modern hard disks use the IDE standard, also known as AT-Bus. This puts most of
the interface electronics on the drive itself, requiring just a cheap expansion card to make 
the connection to the CPU. IDE drives generally have a fast data transfer rate of up to 
1Mbyte/second and beyond.

The main competitor to the IDE standard is SCSI. This interface is mainly used for larger 
drives, although you may find it used with smaller capacity drives on some machines, 
notably Compaq. SCSI comes in two flavours - SCSI-1 and SCSI-2, with SCSI-2 offering much 
faster data transfer rates.

Disk cache
The presence of a cache will affect the data transfer rates and the hard disk access times. A 
hardware cache is likely to improve performance more than a software cache, although you 
may need to use both if the transfer rate between the hardware cache and the CPU is a 
limiting factor. In order to be effective, hardware caches should have at least 1Mbyte of RAM 
on board.

If you don't have a hardware cache then you should use a software cache for optimum 
performance. Although SmartDrive is supplied with Windows, there are a number of 
alternatives which give better performance such as PC-Super Kwik and Fast!. Although cache
size is important, it is unlikely that you will perceive any great benefit in increasing the size 
of the software cache beyond 1Mbyte. A final point: software caches work much faster if 
they are given extended, rather than expanded memory.

System RAMDisk Cache RAM Disk
2 Mbyte 0 Mbyte 0 Mbyte
4 Mbyte 512 Kb 0 Mbyte
6 Mbyte 1 Mbyte 512 Kb
8 Mbyte 1 Mbyte 1 Mbyte
16 Mbyte 1 Mbyte 2 Mbyte

Fragmentation level
The level of disk fragmentation will affect both data access and the overall speed of 
Windows. If a single data or program file is distributed widely across a hard disk, then the 



disk will spend much of its time moving the read/write heads around reading the dispersed 
data, leading to decreased performance as a result.

As a general rule, defragment your hard disk at least once a month using a product like PC 
Tools' Compress or Norton's SpeedDisk. It is also worth defragmenting before you install any 
big new applications.



Video Bottleneck
Your system has a video bottleneck. This means that your graphics adapter cannot keep up 
with the rest of your system. The problem may be due to running your display at a high 
resolution or with a large number of colours. The higher the resolution and number of 
colours, the more data a display card must move about and the slower the system becomes 
as a result. You may be able to improve your performance by moving to a lower resolution 
(800x 600 instead of 1,024 x 768, for example) or by using 16 colours instead of 256.

If you need the high resolution and colour depth, perhaps for desktop publishing or 
computer aided design, then you should consider upgrading your PC with a graphics 
accelerator. These cards remove many of the more onerous video tasks from the main CPU, 
and can increase raw video speed by as much as 200%. There are three main types 
available, each based on a different technology.

S3 cards are currently the cheapest, and offer high performance. However, the 8514/A 
standard might be a better bet if you run other software apart from Windows, since the S3 
standard has not yet attracted the necessary drivers for other applications. The third type, 
the TIGA standard, is mainly used in the DTP and CAD fields and offers potentially the 
highest speed, resolution and colour depth, although it is the most expensive.



Benchmark
A system of routines to test the speed and performance of a computer. The Windows User 
Benchmarks are the only tests currently available which test the speed of all the system 
components while running under Windows.



Bitmap
A bitmap is an image made up of individual pixels. The Windows Paintbrush program can be 
used to create, edit, and view bitmaps.



Cache
A cache is often used to improve the performance of a CPU or a hard disk. Caches work by 
saving the most recently accessed information in fast RAM, so that if this data is required 
again it can be taken directly from fast memory rather than the hard disk or the slow system
RAM.



CIX
The Compulink Information Exchange. CIX is an electronic conferencing system which has a 
huge number of conferences, including many Windows-related ones.    CIX can be joined on-
line on 081-390 1244. Voice contact is available on 081-390 8446.



Colour Depth
Colour depth refers to the number of colours displayed on your screen. An 8-bit colour depth
gives 256 separate colours, whereas a 24-bit colour depth gives over 16 million shades.



CPU
Central Processing Unit. The chip at the heart of the computer, responsible for moving data, 
making calculations and controlling peripherals.



Disk Fragmentation
Disk fragmentation occurs when DOS cannot store data in a single contiguous space on your
hard disk. Instead it distributes the file, using space as and where it finds it. This means that 
a full hard disk can become very fragmented when reading and writing lots of files. 
Fragmentation slows down the overall speed of your PC, but a commercial disk defragmenter
can be used to reorder the files so that all occupy contiguous space and are thus much 
faster to access.



Expanded Memory
Expanded memory (EMS) dates from before pre-Windows days and allows applications to 
store data in banks of 64K. Originally expanded memory was only available in the form of 
special expansion boards, although now all 386 and 486s (and some 286s) can convert 
extended memory into expanded. The standard for expanded memory was devised by Lotus,
Intel and Microsoft (LIM).



Extended Memory
Extended memory is memory above the 1Mbyte line on 286, 386 and 486 machines. 
Windows uses all available extended memory to run programs and store data.



IDE
Integrated Drive Electronics. The IDE interface is the means by which most hard disks 
transfer data to the CPU. The IDE standard puts most of the interface electronics on the 
drive, with only a simple expansion card required.



Landmark
The Landmark test (from Landmark Software) measures raw processor speed in MHz. The 
tests make allowances for wait states, so cached systems give an unrealistically high 
reading (55MHz for a cached 33MHz system) and the test is now little used.



Metafile
A metafile is a collection of instructions used to draw a vector graphic. Since the 
components of the graphic are stored mathematically as coordinates, a metafile can be 
scaled so that it loses no resolution at larger sizes. Metafiles will therefore print at the full 
resolution of your printer, whether it is a 9-pin dot matrix or a 600dpi laser.



MIPS
Millions of Instructions Per Second. The MIPS test benchmarks integer, register and memory 
operations carried out by the CPU. Workstation vendors (and some PC manufacturers) used 
to quote the MIPS performance of their machines, but the MIPS benchmarks are little used 
for testing machines today since overall performance of a system depends upon much more 
than raw processor speed.



Rebooting
Restarting your machine so that changes to the initialisation files (CONFIG.SYS and 
AUTOEXEC.BAT) take effect. You can reboot your machine by hitting Ctrl-Alt-Delete. You 
should not reboot your machine while running a program unless all else fails, since the use 
of a disk cache may cause loss of data. Windows 3.1 will warn you against rebooting your 
machine while it or any applications are running.



Reference System
The computer hardware against which the test results are measured. The Windows User 
Benchmarks are based on a 33MHz 486 machine.



SCSI
Small Computer System Interface. SCSI is a technique for "daisy-chaining" peripherals 
together. Often these are large hard disks, but SCSI is also used to connect tape drives, CD-
ROMs and scanners.



Shell
The shell is the Windows application which loads first when you start Windows and which 
provides access to the system as a whole. Most often this is Program Manager, although 
replacement shells like Norton Desktop, BackMenu and Power Launcher are also popular. You
can change your shell by editing the shell= line in your SYSTEM.INI file.



Status bar

The status bar at the bottom of the Benchmarks window shows the progress of each 
benchmark test as it progresses. It also gives extra help on menu items when you use the 
menu bar.



Tool bar

The tool bar contains a selection of shortcut buttons which can be used as a quick 
alternative to selecting items from the menu bar.



Wait States
The CPU will insert wait states (processor cycles) if the machine's memory is too slow for 
data to be transferred in a single clock cycle. The use of a fast static RAM cache can reduce 
the number of wait states required.



WIN87EM.DLL
A code library supplied with Windows which emulates a hardware-based floating point co-
processor.






